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The software and any related written materials are copyrighted. Unauthorized copying of the 
written materials or the software is expressly forbidden. The licensee or any person renting or 
using the software and written material by other terms may be held legally responsible for any 
copyright infringement that is caused or encouraged by failure to abide by the terms of this 
license. The licensee may make copies of the software solely for backup purposes.  
 
In no event may the licensee transfer, assign, or otherwise dispose of the software except 
with the written permission of the licensor. 
 
In no event will the licensor be held responsible for any damages arising out of the use or 
inability to use this software. 
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1 Introduction 
________________________________________________________________________ 
 
 
WinTomo is a tomographic processing software developed for RAMAC/GPR/BH data. The 
program runs under WIN95/98/ME/2000/XP and is delivered as one file, WinTomo.EXE. 
 
WinTomo runs in Project mode where a project is created for processing data. 
This project contains different information files, which can be read from disk or created 
directly in WinTomo by the user. 
 
Access to traces or palettes are often made by Right clicking on the mouse. 
 
Project files containing first arrivals, borehole co-ordinates, scan list can be saved to be 
used later. 
 

 
Figure 1. Main menu of WinTomo 
 

 
Figure 2. Project window 
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For information about tomography in general we refer to appropriate literature on the 
subject.  
 

We recommend reading previous version of RAMAC Tomography manual or 

CROSSHOLE INVESTIGATIONS. Both these reports can be obtained from MALÅ 
GeoScience Marketing Department. 
 
 

2 Installing the software 
________________________________________________________________________ 
 
 
WinTomo is copy protected through the use of a combination of serial number and 
password; both of which should be provided with your copy of the software (generally 
printed on the CD-cover). 
 

 

2.1 System requirements 
 
The WinTomo software is designed to run on a PC with the following minimum 
specifications: 
 

 133 MHz Pentium 

 32 Mb RAM 

 Window 95/98/NT 
 
It is recommended that the system have at least 100 Mb free hard disk space available for 
processing data. 
 
The amount of available RAM memory to a certain degree determines the speed of 
running RadInter. A minimum of 32 Mbyte is needed but we recommend 64 Mbyte to be 
able to operate the software smoothly. 
 
 

 

 

2.2 Running the software 
 
The shortcut to start WinTomo is found in the MALA GeoScience folder on the Start-
Programs menu in Windows.  
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The main window is the only window that is displayed when ”WinTomo” is started. Here we 
find the main menu as well as the common speed buttons (New-Open-Save-Print-Exit). On 
the main menu bar there are four drop-down menus: 
 
”File” contains functions to load and save data files, creating new files, printing and closing 
the program. 
 
”View” is used to select which windows should be visible. 
 
”Process” contains command to start the more involved processing functions, find first 
arrivals and calculate tomogram. 
 
”Help” is opens the on-line help system containing information about WinTomo. Help 
pages for the active window can also be accessed by pressing the F1 function button.. 
 
If a menu selection is unavailable it is either because it would make no sense in the 
present context or that it might have harmful side effects. When they are needed the 
appropriate menu selections are always available. 
 
 

2.3 Description of windows 
 
The project window shows the status of the five data files in the project. All five are needed 
to perform a tomographic inversion. If no data of a certain type exists within the project, the 
<empty> marker to the right of the data type name indicates this. When a new data file is 
created this marker changes to <unnamed>, to indicate that data are available but has not 
yet been saved. Once the data have been saved the marker changes to reflect the chosen 
filename (<filename>). Opening an existing file also changes the marker to this state 
(<filename>).
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Figure 3. Project window 
 
 
The project window co-operates with main menu when creating and opening data files. To 
create a new instance of a data type, simply mark this in the project window and select 
File-New from the menu in the main window. The resulting dialog lets the user choose 
which type of data should be created. To open an existing data file mark the appropriate 
type in the project window and select File-Open. This activates the open file dialog and lets 
the users select the file to be opened. A short cut to opening a file is to double click on the 
corresponding data type in the project window. This also opens the open file dialog. 

 
Radargram window 
 
The radargram window is quite self-explanatory. It is a simple display of the contents of the 
open data file. The horizontal axis represents the position of the trace in the data file and 
the vertical axis represents time. If there are first arrival data these can also be shown, 
superimposed on the radargram. The first arrival data can be adjusted by dragging the first 
arrival marker to a new position. Double clicking on any trace will open this trace in the 
trace window for closer inspection or a more detailed adjustment of the first arrival. Traces 
marked as bad are displayed in a contrasting solid colour (colour settings are available 
under the Colours tab in the Settings window). 

 
Window is used to display a single trace. It is well suited to make fine adjustments to the 
first arrivals or to judge the effect of applying a band pass filter. The data quality of some 
traces is also inevitably so low that the traces should be removed from further 
interpretation. This is most easily done in the trace window. To mark a displayed trace as 
bad simply press the Mark as bad speed button in the upper part of the window. To 
remove the bad mark, simply press the speed button again. No data is thrown away; a 
trace marked as bad remains in the data file, it is simply not being used in the calculations. 
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Borehole Coordinate and Scan List windows 
 
This window contains all information about the measuring geometry, i.e., the fix and 
moving borehole definitions, as well as the scan-list. Each data set is found under a 
separate tab, and is displayed in a table where it can be edited if necessary. The four 
thumbnail images in the right-hand part of the window shows the three projections of the 
presently active borehole, together with the ray geometry display. Clicking on any of these 
thumbnails will open the full size window for closer inspection. 
 
 

Borehole Geometry window 
 
The borehole geometry window has a very simple task. It displays the projection of the 
selected borehole on the coordinate planes.  
 
 

Ray Pattern window 
 
The ray pattern window displays the position of the boreholes together with the ray 
geometry, as defined by the scan-list. This display is especially useful to locate errors in 
the scan-list or the borehole definition files. The view perpendicular to the tomography 
plane can give the user an idea of the deviations from the basic assumption that all rays lie 
in the same plane. The user can choose to display only selected scans to enhance the 
readability of the display.  
 The ray pattern window can also display the grid geometry chosen for the tomographic 
inversion. This can be an aid in finding the optimum grid geometry (the grid geometry 
settings are available under the Grid tab in the Settings window).  
 
 

Residual Data window 
 
The residual data window displays the residual data as a function of ray. The main 
purpose of this window is to allow the user to adjust the background parameters (velocity 
and time zero, attenuation and transmitted power) in a convenient way. The residual data 
plot looks like a cluster of points. If the assumption that the features in the tomogram are 
deviations from a constant background velocity (or attenuation) is correct, then this cluster 
in centred on the background velocity (or attenuation) which form a straight line in the plot.  
 The background velocity and time zero (attenuation and transmitted power) are correctly 
chosen when the cluster lies horizontally centred on the length-axis.  
 
If they are not it will result in errors in the inverted tomogram like stripes and irregularities 
or other artifacts that will mask the useful information. 
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Ray Check plot window 
 
The ray check plot displays the residual data in a second form. The residual value is 
plotted as the grey level of a pixel in the plot. The position of the pixel is determined by 
considering the depth of the start and endpoints of a ray as rectangular coordinates in the 
plot. This plot is especially useful to locate bad rays and scans. The plot should be fairly 
smooth. If it is not, then there is probably something amiss, either with the radar data or 
the geometry. 
 
 

Tomogram window 
 
The tomogram window is used to display the resulting tomogram. This window is naturally 
not available before an inversion has been performed. 
 
 

3 Entering Data 
________________________________________________________________________ 
 
 

3.1 Data file 
 
WinTomo reads data files created by GPR.EXE for RAMAC/GPR. They should be named 
*.RD3 and accompanied by a header file, *.RAD. These files are automatically output by 
GPR.EXE. 
 

Once the data file is imported Right click on the mouse gives access to a menu for 
zooming data, viewing traces or changing colours. 
 
Bad traces can also be marked here. These are given another colour and will not be used 
further in the processing. They can however be included again. 
 
In the data window the first arrivals can be calculated as in the ”Process” menu. 
 
First arrivals are stored with data in a new file, *.RD6. 
 

3.2 Borehole files 
 
Borehole coordinates can either be read from existing files or be created within the 
program. 
 
Borehole co-ordinates should be read from files named *.FOT. Format for these files 
should be: 
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Text files with data in the following order: 
 

Depth  X-coordinate Y-coordinate Z-coordinate 
 
Commas, space or TAB may separate data. 
 
Data should be referred to in a right-handed co-ordinate system with the positive Z-axis 
downwards. 
 
Once data is read or created it can be viewed with the scan list. By clicking on one of the 
four vertical right windows there are enhanced enlarged. 
 
To create a coordinate file simply left click in the project list on either ”Fix borehole” or 
”Moving borehole”. Thereafter right click on the same. By using the ”New” command a 
coordinate file can be created. 
 
The file name will be ”unnamed” until you right click again on the ”Fix borehole” or ”Moving 
borehole” and save the file. 
 

3.3 Scan list 
 
The scan list may either be read from the data directory as *.LST, or *.TSL  if it has been 
created by GPR.EXE by selecting the TOMOGRAPHY option. Or, a scan list can be 
created within WinTomo. 
 
Once a scan list is read into the project individual numbers in it may be changed or deleted 
as desired. 
 
Whole scans can be excluded from the processing by high lightening the scan no and 
thereafter clicking on the ”√” button. They can be included again by clicking on the same 

button. 
 
To create a scan simply right click on the ”Scan list” option in the project list and select the 
”New” option.  By using the ”Insert row” marker in the upper left corner new rows can be 
entered manually. 
 
In the Scan list there is also the option of entering the ”Antenna offset”. This is the distance 
from the referred 0-point during the survey to the antenna centre. 
 
The correct number to be entered here for the different antenna frequencies are; 
 
100 MHz 0.66 m 
250 MHz 0.33 m 
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3.4 Settings 
 
Settings option contains parameters filtering raw data by bandpass filter, setting of 
template length for first arrival picking, grid parameters, inversion parameters and general 
colour setting. Colour scale settings for data and results can be made separately for each 
colour palette. 
 
 

 
Figure 4. Grid Parameters menu in the Settings menu. 
 

4 Running WinTomo 
________________________________________________________________________ 
 
 

4.1 Setting Parameters 
 
In the ”View> Settings” window you can enter parameters for the different routines in the 
processing as well as the screen colours.  
 
The parameters that should be adjusted besides screen colours are those for; 
 

  Band-pass Filter frequencies 
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  First Arrival Picking window length 

  Grid Size for Inversion 

  General Inversion parameters 
 

 

4.2 Band-pass filter 
 
A band-pass filter can be applied on the raw data. This should be applied in cases where 
the signal amplitudes are very low or noisy causing bad first arrival pickings. The filter 
parameters should be set according to the antenna centre frequency. E.g. when a 100 
MHz antenna has been used 100 MHz can be used as a centre point. The upper and lower 
break points can be set around 75 and 125 MHz respectively. Trial and error will show 
which break points will give the best result. If the break points are chosen too close to each 
other the result is generally an introduced ringing in the data. 
 
By clicking on the square marked ”Apply BP-filter” the data will be filtered. Numerous filters 
can be applied by changing the filter parameters and thereafter on the ”OK” square. 
 

4.3 First arrival picking 
 
After importing a data file a first arrival picking can be made direct or after filtering of the 
data. 
  
The first arrival window  length can be selected in number of samples. The length depends 
on the selection of the sampling frequency versus antenna frequency. The total length 
should exceed the pulse length. 
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Figure 5. First arrival picking with ”bad traces” marked in green. 
 

Figure 6. Zoomed part of the first arrival picking. 
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Viewing the first arrivals and by right clicking on the mouse brings you to a menu where 
you can zoom the data, re-pick the arrivals by viewing individual traces or change colour 
settings. You can zoom desired area by left clicking on the mouse and drawing a desired 
square area on the screen. 
 
In zoom mode you can ”drag” the red squares marking first arrival if you wish to change 
the picking. 
 

Clicking on the ” ” sign will mark each trace as ”BAD”, shown by a red colouring. This 
indicates that the trace will not be used in the inversion process. 
 
If a whole section of data should be marked as ”BAD” you can do this by placing the cursor 
at the desired starting point, while holding down the ”SHIFT” key on the keyboard and left 
clicking on the mouse and dragging the cursor to the desired end point. There after click 

on the red marker for ” ”. Such areas will receive the colour specified in the 

”View>Settings>Colours>Bad Trace”. They traces can be reset by performing the same 
procedure again. The result should be that the colour is reset to the original one. 
 
 
To change the colour palette of the radargram you should double click on the desired 
interval to select appropriate colour. 
 
To perform an interpolated scale between selected intervals proceed as follows: 
 

 Left click on the first colour box in the interpolation range. Note that you can perform 
interpolation between numerous intervals at one instance. This box will then become 
lightened. Double click on the same box to select suitable colour. 

 Left double click on the next box to select suitable colour. Then left click on the same 
box to have it lightened. Continue with next box if you chose to have many interpolated 
intervals. 

 Left click on the box marked ”Interpolate”. The colour area between the selected boxes 
will now be interpolated. 

 
Palettes can be saved on the working directory or at any desired directory for future use. 
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4.4 Grid size 
 
The ”Grid size” option is used to define the inversion area as well as pixel sizes for 
inversion and interpolation. 
 
Normally the inversion areas need to be defined with a certain offset in order to include the 
all rays in the transformed coordinate system. This system where the inversion is 
performed uses the FIXED borehole as the Z-axis and the direction vector the second 
borehole as the X-axis. 
 
The pixel size is recommended to be set according to the antenna wavelength, e.g. 1 m for 
the 100 MHz and 0.5 m for the 250 MHz antennas. If the inversion is interrupted by e.g. 
too little RAM memory in the computer the pixel size can be increased some to save 
memory. 
 
 

4.5 Data quality checking 
 
Data quality checking consists of two separate steps where parameters are determined 
depending on whether amplitude or time data are studied. 
 
Residual/distance plot and Ray Check Plot are the two plots top be studied. From these 

the Background Attenuation/Velocity and Transmitter Power/Start Time of the pulse 
should be determined. 
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The determination of these parameters is carried out in such way to align the residual data 
points on a horizontal line centred around a zero-background value. 
 
Velocity and attenuation are calculated as the quotient between distance/time and 
amplitude/distance respectively. Therefor these parameters mainly determine the slope of 
the data sets. By adjusting these parameters the slope of the data sets can be changed. 
 
Start time and Transmitter Power represent offset values that determine the level of the 
data on the vertical axis. 
 
However, Start Time in the arrival data affects both the level and the slope of data so 
regarding the velocity inversion the data reduction process might turn out to be some more 
”tricky” compared to the attenuation data.  
 
 
Individual data or scans can be viewed and re-picked by clicking on the data cross 
. 

 
Figure 7.  Residual time window. 
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The ray check plot shows graphically each measured trace residual value after background 
removal. 
 
It shows each scan horizontally with the option to disclose all traces regarded as ”bad” and 
not given as input to the inversion process. 
 

 
Figure 8. Ray Check plot 
 
 
 
 
Once this is achieved the residual data are ready for tomographic inversion. 
By clicking on a selected square representing one trace that trace is brought up on the 
screen. The arrival can be re-picked  manually by hand for that trace by moving the arrival 
marker. Or, the arrival data for the whole data set can be re-picked by clicking on the 
coordinate system marker at the top. 
 

NOTE: If you have been re-picking data manually you should be careful to perform a new 
pick on the whole data set as this will erase your manual picking. 
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4.6 Inversion of data 
 
Inversion parameters are set in the ”Settings” menu. The min and max values can be 
changed from the pre-set values if desired. Generally speaking these values set 
constraints to the inversion result. Therefore any predetermined value of these parameters 
can be entered as aid. If no pre-information is available the min and max values should be 
set to cover a maximum interval, e.g. 20-200 for velocity and 0.1-50 for attenuation.  
 
The inversion routing used is a modified Conjugate Gradient method, which is an iterative 
method. It converges fast and therefor the necessary number of iterations can be set 
generally as low as 5. 
 
The damping factor is a wavelength damping factor set on the inversion to smooth it. 
Generally values between 0.1 and 5 give the best results. 
 
Inversion can be made on both velocity and attenuation. The resulting values are 

expressed in either m/ s or dB/m respectively. 
 
 
After finished inversion the data can be interpolated by setting the desired pixel size. 
 
By right clicking on the mouse the tomogram can be zoomed, boreholes can be shown and 
the colour palette be changed by clicking on the colour bar and setting the desired colours. 
 
Intermediate colours can be inserted at the desired value point and dragged up or down 
along the colour scale. 
 
The scale can be selected to be viewed as “Automatic” or as “Manual”. 
“Automatic” in this case means that the minimum and maximum values appearing in the 
resulting pixel values will be set as limits to the colour scale. 
“Manual”  means that the operator can insert values as limits to the colour scale. 
 
In case the operation of setting manual scales does not function the operation should be 
repeated once again by insert the values again. 
 
The tomograms can be printed on the selected printer entered in the “File>Printer Setup” 
menu. 
 
The tomogram is automatically scaled to the full-page version on to the paper that is 
selected in the print menu. 
 
In this delivered version the tomogram is displayed with the Z-axis along the “FIX” 
borehole. The zero point along that axis is set to the first ray point in the scan list, adjusted 
for any offset set in the scan list.  
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The velocity or attenuation data behind the tomographic images can be exported into a 
text file for further processing or presentation using additional software. To export the data 
make the tomogram window active and select Save As from the file menu. The default file 
extension is TOM. One truncated example of such exported data is shown below: 
 
Tomogram type : amplitude 

Background attenuation = 3.00 dB/m 

Transmitted power =  115.00 dB 

Damping factor =  50.000 

Number of iterations = 10 

 

0.400000, 0.200000, 2.049647  

0.400000, 1.200000, 1.972682  

0.400000, 2.200000, 3.473368  

0.400000, 3.200000, 2.949587  

0.400000, 4.200000, 2.403549  

0.400000, 5.200000, 2.823905 

 

The first six lines contain information about the processing performed to realize the 
tomogram plus a blank line. Following this header is the actual data in the format: 
X-coordinate, Z-coordinate, velocity or attenuation. The coordinates given are the 
coordinates for the centre of each cell in the tomogram. 

 
Figure 8.  Tomogram output. 
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